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Preface 
 
 

 

Izenda Reports enables you to easily access your databases directly and quickly transform raw data into 

useful and readily understood information. With Reports you can extract the information you need from 
one or more related tables and format it into tables, reports, or charts. You can view the resulting 
report in your Web-browser and then print it. You can also export reports in several formats, including 
Microsoft Word, Microsoft Excel, and Adobe PDF. 
 
Imagine that your boss has asked for a list of outstanding sales orders for each customer. You know 
that your database has a table called Customers, and another table called Orders, and that they can be 
linked together using the common field called CustomerID. Using Reports, you can “join” the two tables 
and then choose the data fields you need, such as customer name, phone number, order number, order 
date, and order amount. You can use a filter to select only open orders. You can sort the data by 
customer. Finally you can view or print the report, create the report as a PDF file, or output it to Excel.  
 
It is so easy. It is so fast. Your boss will be amazed. 
 
This user manual will step you through each simple process in using Reports, and provide you with 
what you need to know to create your queries and reports. Any data that your application developer 
has included in the database can be accessible to you in creating ad hoc reports. 
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1.0  INTRODUCTION TO IZENDA REPORTS 

 
Izenda Reports is a reporting solution that allows you to design and run reports from a web browser.  It 
consists of a Report List, Report Viewer, and Report Designer and other pages that list and view 
reports. 
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2.0 QUICK START GUIDE 

 
2.1 Building your first report 

 Navigate to the Report List page (http://host/yourApp/ReportList.aspx)  

 Click the "Design A New Report" link  

 
Click to design a new report 

 

 Select a report data source in the "Data Sources" tab (the drop-down contains tables 

and views) like Invoices or Orders  

 
Figure 2-1 Select Views and Tables 

 

 

 

http://host/yourApp/ReportList.aspx
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 Select one or more fields, such as LastName, or OrderId, from the "Field" drop-downs  

 
Figure 2-2 Select Fields 

 Click the "Preview" tab  

 
Figure 2-3 Click the preview tab 
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 Click the "Save" button to save your report  

 
Figure 2-4 Click “Save” to save your report 

 Enter a name and category(optional) in the "Save" dialog box  

 
Figure 2-5 Enter a report name and/or report category in the dialog box 

You now have your first functional report. This is a very basic example, and Izenda Reports 
offers far more capabilities.  
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3.0 THE REPORT LIST 

 
The Report List is first page that you, the user, typically interacts with unless given a link to a specific 
report. This page displays the list of reports. By default, it displays uncategorized reports first in 
alphabetical order and then displays an alphabetized list of the reports by category.  
 
Report links are shown in blue below. Clicking on a report link loads the report into the report viewer. 

You can also click on the delete and modify buttons, shown by the red arrow below ( 

Figure 3-1), to delete the report and load the report into the Report Designer to be modified. 

 

 
 

Figure 3-1 Typical Report List 
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Using this page (depending on your administrator’s setup), you may be able to: 
 

 view an existing report 

 create a new report 

 delete an existing report 

 modify an existing report 
 
All of these options depend upon how your report administrator has configured Izenda Reports. Some, 
none or all of these options may be available to you. 
 
 

3.1 Viewing a Report 

 

 
Figure 3-2 Clickable Report Links 

The report names are hyper-links, which are clicked to load the report into the report viewer.   
 

3.2 The “Design a New Report” Link 

 

 
Figure 3-3 Design a New Report Link 

 
This is a special link. Clicking this link takes you to the report designer where you can create a new 
report. 
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3.3 The Delete and Modify Buttons 

 

 
Figure 3-4 Report Link, Delete & Modify Buttons 

The delete button  allows you to delete a report.  Clicking it will pop-up a dialog box confirming your 
choice to delete. 
 
The modify button  allows you to modify the report by loading the report in the report designer.  
Clicking it will load the report into the report designer. 
 
 
4.0 THE REPORT VIEWER 

 

 
The Report Viewer is used to view the reports that are listed in the Report List. The user typically 
interacts with this page in order to view reports. When loaded, the page displays the report with a 
menu of options on the top of the page. 
 
 

 
Figure 4-1 Report Viewer 

 
 
The Report Viewer buttons allow you to do common tasks associated with viewing a report. 

Report Viewer Buttons 

Button Name Function 

Export Exports the report in the selected format 

Design Switches to Designer so the user can modify the report 

Report List Displays the list of reports 

Show/Hide Filters Allows the user to either display or hide the filters in the Report Viewer 

Update Results Allows the user to add update the report results after adding/removing filters or 
fields 

Add Field Allows the use to add a field to the report 

Delete Field Allows users to delete a field from the report 

Back Allows the user to return to the previous page 
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The dropdowns in the Report Viewer also add the ability to add filters, fields and change the export 
type. 
 

Report  Viewer Drop-downs 

Dropdown Function 

Reports Allows the user to select a different report to view 

Results Allows the user to select the number of results in the report shown on the screen (using 
powers of 10) 

Add Field Adds a new field to the report 

Export Type Determines what format to export the report in 

Filter Field Selects the field to be filtered 

Operator Allows user to choose an operator for the filter 

 
Users can filter in the Report Viewer by using the filter menu shown in Figure 4-2. They have the ability 
to select filter fields and operators, and to add filters If needed. 
 

 
Figure 4-2 Report Viewer Filters 

 
5.0 THE REPORT DESIGNER 

 
The Report Designer (Figure 5-1) provides the means to specify parameters for the table(s) of your 
databases.  
 

 
Figure 5-1 Report Designer Toolbar 
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5.1 Reports Tab 
 

The Reports tab (Figure 5-2) provides another list of created reports. 
 

 
Figure 5-2 Reports Tab 

 

5.2 Data Sources Tab 

 
The Data Sources tab (Figure 5-3) shows which tables and views are already stored in the database. 
Also provides a choice of which table to view or which tables you would like to join. To join two tables 
and/or views, they must have fields with identical entries. For example, both the Customers and the 
Orders tables have the same CustomerID field that contains one of several possible entries: beverages, 
condiments, dairy products, seafood, and so on. 
 

 
Figure 5-3 Data Sources Tab 
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5.2.1 Table Dropdown Menu 

 
The Table dropdown menu (Figure 5-4) is a list of the tables and views available to the user, as shown 
in Figure 4. Select the desired table/view to preview. To join multiple tables or views that have a field 
with identical entries, select those tables/views.  
 
NOTE: A view is a set of tables that have already been joined. 
 

 
Figure 5-4 Table Dropdown Menu 
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5.2.2 Join Field Dropdown Menu 

 
The Join Field dropdown menu (Figure 5-5) is a list of the fields contained in the table/view selected in 
the Table dropdown menu to the left. Select the field that has identical entries as the table/view that it 
needs to be joined with. 
 

 
Figure 5-5 Join Field Dropdown Menu 

 

5.2.3 Foreign Table Dropdown Menu 

 
The Foreign Table dropdown menu (Figure 5-6) is a list of the tables/views that have been selected in 
the Table dropdown menu, other than the one in that row. Select the table/view to join the table/view 
in that row. 
 

 
Figure 5-6 Foreign Table Dropdown Menu 
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5.2.4 Field Dropdown Menu 

 
The Field dropdown menu (Figure 5-7) is a list of fields in the table/view that are selected in the 
Foreign Table dropdown menu to the left. Select the field to join with the table/view in that row. 
 

 
Figure 5-7 Field Dropdown Menu 

 

5.2.5 Join Type Dropdown Menu 

 
The Join Type dropdown menu (Figure 5-8) is a list of the available joining methods. The “Inner” 
method discards any objects from the joint fields that do not have an identical match. The “Left” 
method still displays those without an identical match 
 

 
Figure 5-8 Join Type Dropdown Menu 

 

5.2.6 Function Buttons of Data Sources Tab 

 
From examples in sections 2.2.2 to 2.2.5, two tables, Customers and Orders, have been used. 
CustomerID is the join field of both the Customers and Orders table and Inner (direct) is the join type. 
  
 

 
Figure 5-9 Function Buttons 
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The ,  , and  function buttons are defined in Table 2 below. 
 
 

Icons Control Name Description 

 Delete button Click this button to delete the row the 
button is on. 

 Insert Row 
button (above) 

Click this button to insert a row above the 
row the button is on. 

 Insert Row 
button(below) 

Click this button to insert a row below the 
row the button is on. 

 

Table 2 Function Buttons of Data Sources Tab 
 

5.2.7 Show Data Sources As Check Boxes 

 
In the sections 5.2.1 - 5.2.6 was described the work with drop-down styled Data Sources tab. This is 
default mode for Data Sources tab but you can change it by setting to true 
ShowDataSourcesAsCheckBoxes setting. ShowDataSourcesAsCheckBoxes will turn Data Sources tab 
to the check boxes styled mode (Figure 5-10). 
 

 
Figure 5-10 Check box styled Data Sources 

 

5.2.8 Join Tables In Check Boxes Mode 

 
To join tables in check boxes mode you should just check the tables you want to join one after another. 
When you will check the first table all tables that cannot be joined to it automatically will be disabled. 
After you will select next table to join the list of available (checkable) tables will be refreshed (Figure 
5-11). 
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You will not able to specify manually the joined fields in this mode. Instead of it system will try to join 
tables using information about Foreign Keys. If you will need in manually joining you can always switch 
to the drop-down (advanced) mode by clicking Advanced button. 
 

 
Figure 5-11 Auto Disabling Data Sources To Join 

 

5.3 Fields Tab 

 
In the Fields tab, choose which field of the table/view in the Data Sources tab to display, as well as 
what format is desired.  
 

 
Figure 5-12 Fields Tab 
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5.3.1 Field Dropdown Menu 

 
The Field dropdown menu (Figure 5-13) is a list of the available fields in the table/view that is selected 
in the Data Sources tab. If joining tables/view, the title of the table/view that the field is from appears 
in parenthesis next to the name of the field. Select the fields to display. The entries in the list that are  
in Bold are the table/datasource names. 
 

 
Figure 5-13 Field Dropdown Menu 

5.3.2 Description 

 
Inputs the description of the field selected in the Field dropdown menu to the left. The description 
appears as the new title of the field when the table/view is displayed (Figure 5-14).  
 
NOTE: A default description always appears in this box, but may be edited. 
 
 

 
Figure 5-14 Description  
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5.3.3 Sort and VG Check Boxes and Function Dropdown Menu 

 
Figure 5-15 shows the Sort and VG Check Boxes and Function dropdown menu. 
 
 

 
Figure 5-15 Sort, Group, and VG Check Boxes and Function Dropdown Menu 

 

Table 3 explains the Sort, Group, and VG Check Boxes and Function dropdown menu features. 
 

Features Description 

Sort check box Check this box if you want the table/view to be sorted by 
the field selected in the Field dropdown menu to the left 
in ascending order. 

Sort (z-a)  This check box is in the advanced properties of the row  
and can be set if you want the table/view to be sorted by 
the field selected in the Field dropdown menu to the left 
in descending order. 

VG check box Check this box to change the column for the field selected 
in the Field dropdown menu to the left into subheadings 
 

Function dropdown 
menu 

Functions can be chosen from the dropdown menu. If the 
Group option is selected a group of fields can be created. 
See Function Descriptions for more information. 

 

Table 3 Descriptions of Sort, Group, and VG Check Boxes and Dropdown Menu 
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5.3.4 Width 

 
The Width is shown in Figure 5-16. Enter the width (default unit is px) of the column in the table 
produced that holds the values for the field selected in the Field dropdown menu directly to the left. 
 
 

 
Figure 5-16 Width and Format Dropdown Menu 

 

 
Figure 5-17 Date Format Dropdown Menu 
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5.3.5 Format Dropdown Menu 

 

The Format dropdown menu is a list of formats for the entries of the field selected in the Field 
dropdown menu directly to the left to appear in. 
 

Format Description Examples 

0,000 
 
 

Displays the number as a whole 
number. 

1 
123 
1,234 
1,234,567  

$0.00 
 
 

Displays the number as a 
currency 

$123.45 
$0.12 

0.0 
 
 

Displays the number with one 
decimal place 

123.5 

0.00 
 
 

Displays the number with two 
decimal places 

123.46 

0.000 
 
 

Displays the number with three 
decimal places 

123.456 

0% Displays the number as a 
percentage 

1% 
12% 

 
If the field in the Field dropdown menu directly to the left is a date, the Format dropdown menu will 
look like this: 
 
Format Description Examples 

Short Date Displays the date using the 
mm/dd/yyyy format 
 

8/1/1996 

Long Date Displays the day of the week, 
month, numeric day, and the 
year 

Friday, August 09, 1996 

Short Time Displays time as hh:mm 
AM/PM 
 
 

12:34 AM 
 

Long Time Displays time as hh:mm:ss 
AM/PM 
 

12:34:56 PM 

Full(short) Displays the Long Date Friday, August 30, 1996 4:34 
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format, followed by the Short 
Time format 

PM 

Full(long) Displays the Long Date 
format, followed by the Long 
Time format 

Wednesday, October 23, 1996 
2:28:37 AM 

D&T (short) Displays the Short Date 
format, followed by the Short 
Time format 

3/12/1996 7:45 PM 

D&T (long) Displays the Short Date 
format, followed by the Long 
Time format 

2/27/1996 12:45:13 AM 

 
 

5.3.6 Function Buttons of Fields Tab 

 

The  ,  , and  function buttons shown in Figure 5-18 are for the rows that they are in. 
 
 

 
Figure 5-18 Function Buttons of Fields Tab 

 
 
Table 4 describes the function buttons of the Fields tab. 
 

Icons Control Name Description 

 Delete button Click this button to delete the row the button is on. 

 Insert Row 
button (above) 

Click this button to insert a row above the row the button is on. 

 Insert Row 
button (below) 

Click this button to insert a row below the row the button is on. 

 
Move Allows user to move a row up or down in the list 

 
Advanced 
Properties 

Advanced properties for that row. 

 

Table 4 Function Buttons of Fields Tab 
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5.3.7 Add All Fields From Menu 

 
Figure 5-19 shows the Quick Add Fields from menu. 
 

 
Figure 5-19 Add All Fields From Menu 

 
Table 5 explains the function of each element of the Add All Fields From menu. 
 

Features Description 

Quick Fields From Dialog 
menu  

List of tables/views selected in the Data Sources tab. 

Add Pivot  Allows the user to add a pivot table to a report 

Continue to Summary Allows the user to advance to the Summary Tab 

Preview  Allows the user Preview the current report. 

 
Table 5 Add All Fields From Menu, Add All / Remove All 

 
 

5.4 Filters Tab 

 
In the Filters tab (Figure 5-20), the fields of the table/view chosen in the Data Sources tab can be 
filtered so that only pertinent entries appear in the table. 
 

 
Figure 5-20 Filters Tab 
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5.4.1 Filter Field Dropdown Menu 

 

The Filter Field dropdown menu is a list of the available fields in the table/view that have been selected 
or created in the Data Sources tab. Select the fields to filter. If joining tables/view, the title of the 
table/view that the field is from appears in parentheses next to the name of the field. 
 

 

 

Figure 5-21 Field Dropdown Menu 

 

5.4.2 Operator Dropdown Menu and Value(s)  

 
Figure 5-22 shows the Operator dropdown menu and value(s) features. 
 

 
 

Figure 5-22 Operator Dropdown Menu and Value(s). 
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Table 6 describes the Operator dropdown menu and value(s) features. 
 

Features Description 

Operator dropdown menu List of operations available to perform on field 
selected in the Field dropdown menu to the left. 

Value(s).  
 

Enter the value to which the operation selected in 
the Operator dropdown menu will be applied (for 
example, “Begins With A” only displays items that 
have entries that start with “A” in the selected field). 

 

Table 6 Description of Operator Dropdown Menu and Value(s) 
 
 

 

5.4.3 Blank and Param Checkboxes 

 
The blank and param boxes (see Figure 5-23 Function Buttons) allow you to control the filtering 
behavior in the report viewer, they do not affect the “Preview” tab of the report designer. 
 
Param Checkbox:  To use this, first set a “Filter Field”, set an “Operator”, and then set “Value(s)”.  This 
will display the filtered report in the report viewer and allow the user to change the filter value.  If it is 
not checked, then the filter will not be visible to the end-user and the end-user will not be able to 
change the filter. 
 
For example, the Figure 5-23 Function Buttons” shows a filter which will display a report in the report 
viewer where only the Address fields which begin with “s” will be shown.  However, a user will be able 
to change the “s” to a “t” and update the report if desired. 
 
Blank Checkbox:  To use this, first set a “Filter Field” and then set an “Operator.”  

If “Blank” is checked, the filter will return data which matches the “Value(s)” 
dropdown/textbox and also data which has a blank/null value in that field . 

 
For example, if we also checked “Blank” in Figure 5-23 Function Buttons” and then viewed the report in 
the report viewer, then the user would see all of the data where the “Address” begins with “s”  and all 
of the “Address” record which are blank or null. 
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5.4.4 Function Buttons 

 

The ,  ,  ,  and  function buttons of the Filters tab are shown in Figure 5-23. 
 
 

 
Figure 5-23 Function Buttons 

 
 
 
 

Table 7 describes the function buttons of the Filters tab. 
 
 

Icons Control Name Description 

 Delete button Click this button to delete the row the button is on. 

 Insert Row 
button (above) 

Click this button to insert a row above the row the button is 
on. 

 Insert Row 
button (below) 

Click this button to insert a row below the row the button is 
on. 

 
Move  Allows users to move a row up or down in the list. 

 

Table 7 Descriptions of Function Buttons 
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5.5 Summary Tab 

 
In the Summary tab (Figure 5-24), a table can be created that summarizes the chosen fields using 
different functions (Ex: Average, Count, Maximum, and so on). You can also make a group of fields by 
choosing the Group option from the Function dropdown menu. 
 

 
Figure 5-24 Summary Tab 

 

5.5.1 Field Dropdown Menu 

 
The Field dropdown menu (Figure 5-25) is a list of available fields in the table/view that have been 
selected/created in the Data Sources tab and that have numeric entries. Select the fields to 
summarize.  
 

 
Figure 5-25 Field Dropdown Menu 
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5.5.2 Description 

 

The Description text box (Figure 5-26) inputs the description of the field selected in the Field 
dropdown menu to the left. The description appears as the new title of the field when the Summary 
Table is displayed. 
 
NOTE: A default description always appears in this box, but may be edited. 
 
 

 
 

Figure 5-26 Description Text Box 

 
 

5.5.3 Sort Check Box, VG Check Box and Function Dropdown Menu 

 
The Sort check box, VG check box, and the Function dropdown menu are shown in Figure 5-27. 
 

 
Figure 5-27 Sort Check Box and Function Dropdown Menu 
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Table 8 describes the Sort (a-z) check box, Sort (z-a) check box, and Function dropdown menu 
features. 
 

Features Description 

Sort check box  
 
 

Checking this box causes the table/view to be sorted by the 
field selected in the Field dropdown menu to the left in 
ascending order. 
 

VG check box 
 

Checking this box causes the report to be visually grouped by 
that column. 
 

Function 
dropdown menu 

Lists the functions that may be applied to the field. (Ex: 
Choosing Average causes the Summary Table to display the 
average value for the entries in the field selected in the Field 
dropdown menu. Note:  each selection must be either grouped 
or a function or all can be None. 

 

Table 8 Descriptions of Sort Check Box and Function Dropdown Menu 
 
 

5.5.4 Format Dropdown Menu 

 
This is the same format as the Format Dropdown Menu from the Fields tab. See Section 2.3.5 

5.5.5 Function Buttons 

 

The ,  ,  ,  and  function buttons are shown in Figure 5-28. 
 
 

 
 

Figure 5-28 Function Buttons 
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Table 9 describes the function buttons. 
 

Icons Control Name Description 

 Delete button Click this button to delete the row the button is on. 

 Insert Row 
button (above) 

Click this button to insert a row above the row the button is 
on. 

 Insert Row 
button (below) 

Click this button to insert a row below the row the button is 
on. 

 
Advanced 
Properties 

Allows user to set Advance Properties for each row 

 
Move  Allows user to move a row up or down in the list 

 
 

Table 9 Description of Function Buttons 
 

5.6 Chart Tab 

 
In the Chart tab (Figure 5-29), a chart can be created using the data in the table/view selected on the 
Data Sources tab. 
 

 
 

Figure 5-29 Chart Tab 

 

5.6.1 None Selection 

 
When the chart type (Figure 5-30) is None (…), no chart appears. 
 

 
Figure 5-30 None Selection 
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Trend Selection 
 
When the chart type is Trend (Figure 5-31), the chart appears in Trend format. 
 

 
Figure 5-31 Trend Selection 

 

Table 11 describes the features of the Trend chart type selection. 
 

Features Description 

Trend chart  By choosing chart type Trend, the chart appears in Trend format.  

Date dropdown 
menu  

Choose any field of date format like birth date, join date, and so 
on. 

Value dropdown 
menu 

Choose any value from the dropdown list. 

 

Table 11 Description of Trend Chart Type 
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5.6.2 Pie Selection 

 
Figure 5-32 shows the Pie (chart) selection menu of the Chart tab. 
 

 
 

Figure 5-32 Pie (Chart) Selection 

 
Table 12 describes the Pie chart selection. 
 

Features Description 

Pie chart  By choosing chart type Pie, the chart appears in 
Pie format.  

Label dropdown menu  Choose any label from the dropdown list. 

Value dropdown menu Choose any value from the dropdown list. 

 

Table 12 Description of Pie (Chart) Selection  
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5.6.3 Plot Selection 

 
Figure 5-33 shows the Plot (chart) selection of the Chart tab. 
 

 
Figure 5-33 Plot Selection 

 
Table 13 describes the Plot (chart) selection. 
 

Features Description 

Plot chart  By choosing chart type Plot, the chart appears in 
Plot format.  

X-axis dropdown menu  Choose any field from the dropdown for the X-axis. 

Y-axis dropdown menu Choose any field from the dropdown for the Y-axis. 

 

Table 13 Description of Plot (Chart) Selection  
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5.6.4 Bar Selection 

 
Figure 5-34 shows the Bar chart selection of the Chart tab. 
 

 
 

Figure 5-34 Bar Selection 

 
Table 14 describes the Bar (chart) selection entries. 
 

Features Description 

Bar chart  By choosing chart type Bar, the chart appears in 
Bar format.  

Label dropdown menu  Choose any label from the dropdown list. 

Value dropdown menu Choose any value from the dropdown list. 
 

Table 14 Description of Bar (Chart) Selection  
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5.7 Funnel Chart 

 
Figure 5-33 shows the Funnel chart selection of the Chart tab. 
 
 

 
 

Figure 5-33 Funnel Selection 
 

Features Description 

Bar chart  By choosing chart type Bar, the chart appears in 
Bar format.  

Title Insert name for the chart 

Label dropdown menu  Choose any label from the dropdown list. 

Value dropdown menu Choose any value from the dropdown list. 
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5.8 Gauge Tab 

 
In the Gauge tab, you can add a panel of radial or linear gauges to a report.   
 

 
 

Figure 5-34 Gauge tab contents 

 
 
 
Results:   Allows you to specify how many gauges you want to show, if you choose to count the  
   number of products in multiple categories, you could specify that you want to only  
   show the first 4 categories by alphabetical order. 
 
Name:      Choose the gauge labels 
Value:      Chose the field to which a function is applied. 
Function:   Choose a function to apply to the field.   
Radial/Linear:  See table below. 
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Radial gauge 

 

Radial Gauge 2 

 

Linear gauge 
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5.9 Misc Tab 

 
In the Misc Tab, you can add a title, description, header and footer of the report. Scheduling is also 
done in the Misc tab. 
 

 
 

Figure 5-35 Misc tab contents 

 
Title:     Enter the title of the report.   
Description: Enter a description for the report.  
Header:    Allows a user to set a report header.  
Footer:    Allows a user to set a report footer. 
 
By clicking little boxes right to the Title/ Description/ Header/ Footer text boxes you can set the 
corresponding item justification. Justification can be either L(Left), M(Middle) or R(Right). 



Izenda Reports                User’s Guide 
 

 

Izenda Reports User’s Guide v6.4   
40 

Shared/Read only:  Selecting “Shared” will allow other users to see your report and modify it.  Selecting 
“Read only” set the report so that it is only modifiable by the report owner and View Only allows the 
user to simply view the report and not make any modifications.  
 
Category:  Set the category of the report.  Note:  this is set automatically when you save with a 
category. 
 
Note: The scheduling controls may not be available to all users, if you do not see them, please speak 
with your system administrator. The scheduling controls allow you to schedule a report to be emailed 
on a recurring basis. 
 
Schedule:   Set the schedule date and time.   
Repeat Type:  Set the repeat frequency. 
Send Email As:  Sets the format in which the email is sent. 
Recipients:   Enter a comma separated list of recipients. 
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5.10 Style Tab 

 
In the Style tab, you can customize the look of the table.  You can change the color of the border, 
header, and rows.  The order of report items can also be changed. 
 

 
 

Figure 5-36 Style tab contents 
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Report style properties can be changed using the drop-downs, when the properties are changed, the 
sample grid below can be used to see the differences.   
 
The colors which can be changed are: Border color, Header color, Header foreground color, Item color, 
Item foreground color, and Alternating item color. 
 
Explanations of other properties found on tab are given below. 
 
Landscape printing:       Determines whether the report prints in landscape mode. (It can  

also be set using print properties in the printer dialogue box) 
Show page number in pdf:     Sets whether the page numbers are shown in pdf report  

exports. 
Show date and time in pdf:    Sets whether the date and time are shown in  pdf report  

exports. 
 
Use pagination in web view:    Sets whether pagination is used in the report viewer. 
 
Add bookmark for each visual group:  Sets whether bookmarks are used in adobe pdf exports. 
 
Show Visual Group Label:     Sets whether the visual group labels are shown. 
 
Items per page:        Allows a user to set the number of items show per page in a grid. 
 
Report order:         Allows the user to set the order of the Summary, Chart, Gauges  

and Detail grids 
 
  
Field|Value column pairs:     Allows a user to set the field value style.  This is useful for  

Accounting/financial reports. 
 
Show main report in Field | Value style:  Allows a user to set whether the main detail grid uses  

Field-Value style 
 
Show summary report in Field | Value style: Allows a user to set whether the summary grid uses 

Field-Value style 
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5.11 Preview Tab 

 
In the Preview tab (Figure 5-), a preliminary version of the created table can be viewed, along with its 
Summary Table, description, and chart. Go back and change selections in the previous tabs and see 
how they affect the table by returning to it in the Preview tab. 
 
 

 
 

Figure 5-37 Preview Tab 

 
 

5.12 Toolbar 

 
Figure 5- shows the Toolbar buttons. 
 

 
 

Figure 5-38 Toolbar Buttons 
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Table 15 describes the functions of the Toolbar buttons. 
 

Icons Features Description 

 Back Goes to the browser’s previous page. 

 New  Creates a new report. 

 Save Saves a report. 

 Save As Allows a new report name to be saved. 

 Print (PDF Export) Saves the report as a PDF document. 

 IE Runs the report in the web browser. 

 Schema Display database diagram 

 SQL Views the report in SQL mode. 

 CSV Saves the report as a CSV file. 

 Excel Spread sheet Saves the report as a MS-EXCEL file. 

 Word Document Saves the report as a MS-Word document. 

 XML document Saves the report as a XML document. 

 
Open office 
document 

Saves the report as an Open Office Document. 

 RTF document Saves the report as a RTF document 

 Back to Report List Takes you to the Report List screen. 

 E-mail E-mails a report to a client 

 Settings Takes you to Settings.aspx page. 

 
 

Table 15 Descriptions of Toolbar Buttons 
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5.12.1 Back Button 

 
Use this button to go back to the browser’s previous page. 
 

5.12.2 New Button 

 
Use this button to create a new report according to your query. The new report is created, and the 
existing report is refreshed. 

5.12.3 Save Button 

 

The Save button is used to save any report, created with a specified name, in the saved reports list. 
Figure 5- shows the Save Any Report script prompt. 

 

 
 

Figure 5-39 Save Any Report 
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5.12.4 Go Button 

 
The Go button is used to run a particular report in the web browser. It opens a new page to show the 
report as an HTML report (Figure 5-). 
 

 
Figure 5-40 To Run the Report as a HTML Report 
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5.12.5 SQL View 

 
This button is used to view the report in SQL view (Figure 5-). It allows the report to be opened directly 
or saved for future use. 
 

 
 

Figure 5-41 Save Any Report as SQL Format 

 
 

5.12.6 PDF Button 

 
The Pdf button is used to save any report as a .pdf file format that can be used later. Specify the 
location and the file name for better identification. Figure 5- shows the file download screen. 
 

 
 

Figure 5-42 Save Any File as PDF Format 
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Figure 5- shows the screen displayed after the download is complete. 
 

 
 

Figure 5-43 After Completed Download 

 

5.12.7 CSV Button 

 

The CSV button is used to save any report in a specified location as a .CSV format, which can be 
retrieved later. 
 

5.12.8 Spread Sheet Button 

 
The Spread Sheet button is used to save any report in an MS-EXCEL file format , which can retrieved 
later. Specify the save location and the file name. 
 
 

5.12.9 Word Document Button 

 

The Word Document button is used to save any report as an MS-WORD document, which can be 
retrieved later. Specify the location and name only. 
 

5.12.10 XML button 

 

The XML button is used to save any report as an XML document, which can be retrieved later. Specify 
the location and name only. 
 
 
 
 



Izenda Reports                User’s Guide 
 

 

Izenda Reports User’s Guide v6.4   
49 

5.12.11 Open Office Document 

 

This button is used to save any report as an Open Office Document, which can be retrieved later. 
Specify the location and name only. 
 

5.12.12 RTF Document 

 
This button is used to save any report as an RTF Document, which can be retrieved later. Specify the 
location and name only. 
 

5.12.13 E-mail Report 

 
This button is used to e-mail the report to a client. Specify the e-mail address of the recipient only. 
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6.0 PIVOTS SECTION 
 

 

The Izenda reports Pivot feature allows users to generate analytical data grids from within Izenda 
reports. The Pivot feature essentially adds extra pivot columns to the right side of the report. This is 
useful for comparing data over multiple categorical dimensions.  

Pivot View of the average amount spent on freight: 

 

 

6.1.1 Create initial report: 

1. Click on the "Data Sources" tab and select desired data sources. (Ex. Orders) 

2. Click on the "Fields" tab.  Select the desired Field(s) names & attributes (Sorting, VG, Function, 
& Format) for the report. (Ex. ShipCountry)  

 

Before Pivot:  

 
 

Create pivot view on above report: 

1. Under Fields tab, click the "Add Pivot" button. 

2. Drop down "Add pivot columns for".  Select the field you wish to display across the top of the 
pivot view (Ex. OrderDate), also select the function type from drop down (Ex. Group(Year & 
MN)). 
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3. Drop down "Calculate cell values on".  Select the field you wish to display down the left side of 

the pivot view (Ex. Freight), also select the function & format types from the drop downs (ex. 

Average & $0.00).  **This field's data will also populate the rows within the pivot view. 

4. Optional:  Select the "Add subtotals using" drop down.  Select the desired function. (Ex. Sum)  

5. Click Preview 

After Pivot:  

 
 
 

Essentially, the pivot capability adds additional columns based on the data to the right of the report. In 
this example, the first column is essentially a standard report and the 2006, 2007 and 2008 columns 

were added by the pivot capability 

 

Standard Report View: 

 

 

Columns added by Pivot: 
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Let's use these concepts to develop a more sophisticated report that shows us a monthly time-series 
report for each county visually grouped by employee.  

First let's setup the non-pivot part of the report: 

Non-Pivot Report View: 

 

 
 
Here's how we do it: 

1. Here we select and visually group by employee (by clicking the VG checkbox for that field).  

2. We sort on ShipCountry and Sum the Freight.  

3. We then add subtotals using the Sum function to give us a summary line for each employee.  
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Report Designer Setup without Pivot: 

 

Now that the non-pivot is complete, let's do a monthly pivot:  

1. We select the OrderDate to pivot on.  

2. Select the Group(Year & MN) for the formatting of the column names. 

3. Select the sum of freight for the cells.  
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Finally, here are the results of the report with Pivot:  
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7.0 FUNCTION DESCRIPTIONS 

 
The following is a table of functions available for use in the Fields and Summary tab of the Report 
Designer. 
 

Function Name Description 

Group Groups field values together for aggregating 

Count Counts the number of values in a column 

Count Distinct Counts the number of distinct values in a column 

Sum Sums the value in a field 

Average Takes the average value of a field 

Maximum Takes the maximum value in a field 

Minimum Takes the minimum value in a field 

Group(Date),(Day),(Month),(Year) Groups  a date field by its value 

Group(Month Name) Groups a date field by its month value and 
displays the name (March) instead of (03) 
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8.0 GLOSSARY 
 

Database  A collection of data arranged for ease, speed of search, and retrieval. 
   
Entry  A single piece of data that belongs to a field. 
   
Field  A set of entries that are grouped together because of similar properties. 

The Fruit field contains entries that are either apple, peach, or orange. 
   
Table  A set of data organized into fields and arranged in rows and columns. 
   
View  A set of tables that have been joined by similar fields with identical 

entries. 
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